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Program Origin jest bardzo rozbudowany. Umo»liwia zarówno przygotowywanie wykresów, jak te» i analiz¦
danych. Poni»ej przedstawiam jedynie najbardziej podstawowe wskazówki, jak zacz¡¢ efektywnie korzysta¢
z tego narz¦dzia. Jednocze±nie podkre±lam, »e podane przeze mnie metody nie s¡ jedynymi rozwi¡zaniami �
wiele operacji mo»na wykona¢ na kilka sposobów. Ch¦tnie uzupeªni¦ ten mini-poradnik o kolejne podpowie-
dzi � je±li kto± z Czytelników chce si¦ podzieli¢ wiedz¡ o u»ytecznych funkcjach czy trickach, to zapraszam
do kontaktu.

Spis poruszanych zagadnie«:

� Organizacja pracy � kilka wskazówek, jak efektywnie organizowa¢ prac¦ z programem Origin � za-
równo podczas zaj¦¢ w Pracowni Fizycznej, jak te» i podczas pracy naukowej;

� Wprowadzanie danych � wprowadzanie danych z plików, automatyczne wypeªnianie kolumn liczbami,
importowanie wielu plików jednocze±nie.

� Operacje na danych � prowadzenie oblicze« na bazie wprowadzonych danych.

� Tworzenie wykresów � tworzenie wykresów z jedn¡ i dwiema osiami pionowymi, przygotowywanie
wykresów funkcji.

� Eksportowanie wykresów� eksportowanie wykresów tak, »eby mo»na je byªo zamie±ci¢ w sprawozdaniu
lub w Internecie.

� Dopasowywanie funkcji � dopasowywanie funkcji liniowych i nieliniowych, tak»e z uwzgl¦dnieniem
niepewno±ci.



1 Organizacja pracy

Efektywn¡ prac¦ z programem Origin mo»na sobie zapewni¢ stosuj¡c kilka reguª. Mój wybór bazuje z jednej
strony na wªasnym do±wiadczeniu, a z drugiej strony � na obserwacji problemów, jakie napotykaj¡ studenci
podczas pracy w laboratorium i w II Pracowni Fizycznej.

1. Zdecydowanie sugeruj¦ cz¦ste zapisywanie pliku, na którym pracujemy.

2. Zach¦cam do odpowiedniego organizowania �±rodowiska pracy�. Ta metoda wymaga pewnej samody-
scypliny, ale jest niezwykle u»yteczna, szczególnie gdy wracamy do naszych danych po przerwie �
tygodniu, miesi¡cu, roku. Organizacja pracy to cztery proste dziaªania (rys. 1):

(a) grupowanie arkuszy z danymi (workbooków), wykresów oraz innych okien w wewn¦trznych fol-
derach Origina. Foldery te s¡ widoczne w Project Explorer, po lewej stronie okna programu. Je±li
Explorer nie jest widoczny, prawdopodobnie jest automatycznie �zwini¦ty� w lewo w celu oszcz¦dze-
nia miejsca. Przy pomocy �pinezki� (górna belka Explorera) mo»emy mie¢ go zawsze na wierzchu.
Foldery powinny mie¢ rozs¡dne nazwy � np. mog¡ to by¢ daty pomiarów lub nazwy pomia-
rów. (Pod)foldery tworzy si¦ klikaj¡c prawym klawiszem na folderze nadrz¦dnym i wybieraj¡c
New Folder. Obiekty (wykresy, workbooki i inne) mo»na przenosi¢ mi¦dzy folderami korzystaj¡c
z metody �przeci¡gnij i upu±¢�. Obiekty z �niewyra¹n¡� ikonk¡ s¡ ukryte � nie s¡ widoczne jako
okna w gªównym obszarze roboczym programu. Ta funkcja bywa u»yteczna � pozwala utrzyma¢
porz¡dek w obszarze roboczym. Obiekty przywracamy, klikaj¡c dwukrotnie ich nazw¦ w Explore-
rze. Ukrycia obiektu mo»emy dokona¢ albo w Eksplorerze (prawy klawisz → Hide), albo klikaj¡c
krzy»yk zamykania okna na belce. Standardowo, program zapyta nas wtedy czy chcemy okno
zlikwidowa¢ na staªe, czy je ukry¢. Uwaga! Reakcja programu na klikni¦cie krzy»yka mo»e by¢
zmieniona w Preferences → Options. . .→ Open/Close. Jedna z opcji to usuni¦cie okna bez pytania
o potwierdzenie!

(b) dbanie o nadawanie workbookom, arkuszom i wykresom rozs¡dnych nazw (w workbooku, podob-
nie jak w Excelu, mo»emy mie¢ wiele arkuszy; w Originie mo»emy te» mie¢ wiele workbooków).
Ja staram si¦ nadawa¢ podobn¡ nazw¦ workbookowi i wykresom zrobionym na jego bazie. Dzi¦ki
temu, przy wielu wykresach oszcz¦dza si¦ sporo czasu i nerwów zwi¡zanych z wyszukiwaniem
zale»no±ci mi¦dzy oknami. Je±li nie nazwali±my okien i nie wiemy na pierwszy rzut oka, gdzie
s¡ dane do jakiego± wykresu, najlepiej jest klikn¡¢ dwa razy na wykresie (na krzywej lub punk-
tach) i w otwartym okienku klikn¡¢ Workbook. Origin wska»e nam wtedy dane ¹ródªowe. Nazwy
nadajemy oknom klikaj¡c prawym klawiszem na górnej belce okna i wybieraj¡c Properties. Long
name to nazwa nadawana dla wygody u»ytkownika, a ewentualna Short name to nazwa u»ywana
w skryptach automatyzuj¡cych prac¦ z Originem;

(c) unikanie tworzenia nowego workbooka do ka»dego, nawet maªego, zestawu danych. Oczywisty po-
wód to trudno±ci z opanowaniem du»ej liczby okien, szczególnie gdy nie s¡ prawidªowo nazywane.
Drugi powód to niepotrzebne komplikowanie tworzenia wykresów. Wykresy prezentuj¡ce dane
z ró»nych kolumn w jednym arkuszu workbooka mo»na otrzyma¢ jednym klikni¦ciem, natomiast
gdy dane s¡ w ró»nych workbookach czy arkuszach, musimy si¦ wi¦cej napracowa¢;

(d) wstawianie okienka z notatkami, komentarzami itp.

3. Zach¦cam do korzystania z ikon rozmieszczonych wokóª okna programu, dzi¦ki czemu nie musimy szuka¢
potrzebnych nam funkcji w menu (rys. 2, 3, 4). U»ytkownik mo»e dobra¢ zawarto±¢ menu do swoich
potrzeb, usuwaj¡c nieu»ywane ikony, a doª¡czaj¡c inne � patrz rys. 5. W nowych wersjach programu,
przydatne ikony pojawiaj¡ si¦ chwilowo równie» w momencie zaznaczania kolumny (patrz rys. 6) lub
przy jednokrotnym klikni¦ciu na linii lub punktach wykresu.
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Rysunek 1: Gªówne elementy zwi¡zane z efektywn¡ organizacj¡ pracy w Originie.
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Rysunek 2: Ikony najbardziej przydatnych narz¦dzi. Okre±lenia lewe i prawe menu odnosz¡ si¦ do stan-
dardowego ukªadu pasków narz¦dzi po zainstalowaniu programu. U»ytkownik mo»e dowolnie zmienia¢ ten
ukªad.

nowy workbook

nowa funkcja

nowy Layout

nowy notatnik

dodanie nowej
kolumny w workbooku

ustaw zaznaczoną kolumnę
jako X, Y, Z lub niepewności

pokaż/ukryj Project Explorer
(foldery, pliki)

zdublowanie
okna

Rysunek 3: Ikony najbardziej przydatnych narz¦dzi w menu górnym � patrz te» uwaga w podpisie do
poprzedniego rysunku.
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wykres typu linia

wykres w układzie
biegunowym

wykres z dwiema
niezależnymi osiami Y

dla dwóch zestawów danych

modyfikacja ustawienia i perspektywy
wykresów 3D

wykres typu
linia+punkty

wykres typu
punkty

wykresy 3D współrzędne odczytywane
z wykresu (patrz ikony lewego menu)

Rysunek 4: Ikony narz¦dzi wykresów w menu dolnym. Najszybsz¡ metod¡ zrobienia wykresu jest zaznaczenie
w workbooku przynajmniej jednej kolumny typu Y i klikni¦cie ikony odpowieniego typu wykresu. Cz¦±¢
wykresów wymaga zaznaczenia wi¦kszej liczby kolumn. Patrz sekcja Tworzenie wykresów.

Rysunek 5: Dodawanie i usuwanie ikon. Cz¦sto przydatne s¡ te zwi¡zane z importem danych.
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2 Wprowadzanie danych

Najbardziej elementarna metoda wprowadzania danych, to wpisywanie ich r¦cznie w komórki workbooków
� tak jak mo»na to robi¢ w programie Excel. Oczywi±cie ta metoda ma zastosowanie jedynie w sytuacjach,
gdy tych danych jest bardzo maªo.

Je±li dane w której± kolumnie maj¡ przyjmowa¢ warto±ci zgodnie z pewnym schematem (np. maj¡ to
by¢ kolejne liczby naturalne), najlepiej skorzysta¢ z funkcji Set Values. Mo»emy to zrobi¢ na dwa sposoby �
albo wpisuj¡c funkcj¦ w komórce F(x)=, albo zaznaczaj¡c kolumn¦ i wpisuj¡c ctrl+q. W tym drugim przy-
padku nasz¡ funkcj¦ wpisujemy w wygodnym okienku o nazwie Set Values. Bardzo przydatna jest zmienna
�i�, która oznacza numer wiersza. Wpisuj¡c tylko �i� w polu funkcji wypeªniamy kolumn¦ kolejnymi licz-
bami naturalnymi. Mo»emy równie» generowa¢ bardziej skomplikowane dane, np. 2*i, (-1)^i, (i-2)^3 itd.
(rys. 6). Bogate �zoo� dost¦pnych funkcji jest widoczne po klikni¦ciu w Function u góry okienka Set Va-
lues. W okienku tym mo»emy równie» wybra¢ zakres komórek, w których chcemy generowa¢ dane. Liczb¦
π uzyskujemy wpisuj¡c �pi�. Wi¦cej informacji o dziaªaniach na kolumnach (w tym � kiedy te dziaªania s¡
zablokowane) przedstawiam w sekcji Operacje na danych poni»ej.

ctrl+q

Rysunek 6: Automatyczne wypeªnianie kolumn liczbami � bezpo±rednio w komórce lub w dedykowanym
okienku. Przy zaznaczonej kolumnie wida¢ pojawiaj¡cy si¦ na chwil¦ pomocniczy panel z ikonami przydatnych
narz¦dzi.

Zazwyczaj dane eksperymentalne importujemy z plików, które s¡ generowane przez oprogramowanie
u»ywane w eksperymentach. Cz¦sto mo»emy wtedy u»y¢ po prostu metody �przeci¡gnij i upu±¢�, przenosz¡c
bezpo±rednio plik z jego lokalizacji w systemie Windows do workbooka. W tym przypadku koniecznie jednak
musimy sprawdzi¢, jakie dane s¡ w pliku ¹ródªowym i porówna¢ je z danymi, które pojawiªy si¦ w workbooku
(rys. 7).
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dane
prawidłowo

zaimportowane

przeciągnij i upuść

Rysunek 7: Import z pliku metod¡ �przeci¡gnij i upu±¢�. Kolumny w pliku ¹ródªowym byªy oddzielone
tabulacj¡.

Mo»e si¦ zdarzy¢, »e Origin ¹le zinterpretuje separatory kolumn lub kropki/przecinki dziesi¦tne i zaim-
portowane dane b¦d¡ bezu»yteczne (rys. 8) Je±li widzimy, »e dane s¡ nieprawidªowe, korzystamy z narz¦dzia

!!!

przeciągnij i upuść

Rysunek 8: Bª¦dny import z pliku metod¡ �przeci¡gnij i upu±¢�. Kolumny w pliku ¹ródªowym byªy oddzielone
spacj¡.

Data → Import From File → Import Wizard (skrót ctrl+3), które pozwala m.in. na zadanie separatorów ko-
lumn, separatorów dziesi¦tnych (kropka, przecinek) czy uwzgl¦dnienie nagªówków w plikach z danymi. Import
Wizard umo»liwia te» wybranie dodatkowych u»ytecznych ustawie« � przedstawiam je na rys. 9. Na ostat-
nim pokazanym tu panelu mo»emy ju» klikn¡¢ Finish, chyba »e chcemy dokona¢ importu cz¦±ciowego lub
zapisa¢ parametry importu jako szablon � wtedy idziemy dalej. Import wielu plików jednocze±nie do kolej-
nych kolumn (a nie workbooków) jest bardzo przydatny, gdy chcemy porównywa¢ wykresy utworzone na ich
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bazie. Po imporcie, najpierw odpowiednie kolumny oznaczamy jako X (pocz¡tkowo wszystkie b¦d¡ jako Y,
z wyj¡tkiem pierwszej). Nast¦pnie zaznaczamy potrzebne kolumny i tworzymy wykres jednym klikni¦ciem,
zgodnie z opisem w sekcji Tworzenie wykresów.

pomijamy dwa następne panele

warto zaznaczyć, dzięki czemu nazwy
importowanych plików pojawią się

w komentarzach do kolumn

często wygodnie jest importować
dane z wielu plików do nowych kolumn

obok siebie, a nie do nowych workbooków

wybieramy separator
dziesiętny (kropka/przecinek)

wybieramy separator kolumn

wybieramy plik lub pliki
do importu

kontrolujemy poprawność danych

Rysunek 9: Import Wizard � gªówne kroki
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W nowych wersjach programu podj¦to prób¦ pomocy u»ytkownikowi w zachowaniu integralno±ci danych
(rys. 10). Po zaimportowaniu danych z pliku, w lewym górnym rogu workbooka pojawia si¦ zielona ikonka,
oznaczaj¡ca poª¡czenie danego arkusza z plikiem ¹ródªowym. Oznacza to przede wszystkim, »e r¦czna (i te»
zautomatyzowana) edycja danych w zaimportowanych kolumnach jest zablokowana. W tym trybie mo»emy
wybra¢ czy wraz z mody�kacj¡ pliku ¹ródªowego Origin ma za tymi zmianami nie pod¡»a¢, pod¡»a¢ natych-
miast, czy te» pod¡»a¢ przy uruchamianiu projektu. Je±li nie poprosilismy Origina o aktualizowanie danych,
a plik ¹ródªowy zostanie zmody�kowany, ikonka zmieni kolor na »óªty. Tryb poª¡czenia z plikiem ¹ródªowym
pojawia si¦ tak»e w przypadku importu metod¡ �przeci¡gnij i upu±¢�.

plik źródłowy

opcje aktualizacji danych

odłączenie od pliku źródłowego;
połączenie można przywrócić

wybierając
plik w Data Source...

ikona „świeżości danych”
(gdy są nieaktualne jest żółta)

Rysunek 10: Kontrola integralno±ci danych � poª¡czenie danych i plików ¹ródªowych.
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3 Operacje na danych

Operacje na danych w workbookach mog¡ by¢ znacznie bardziej rozbudowane ni» te przedstawione ju» wcze-
±niej. Przede wszystkim, mo»na wygodnie generowa¢ dane na bazie danych ju» istniej¡cych w kolumnach.
Idea tych operacji jest w najnowszych wersjach Origina podobna do tej dobrze znanej z Excela. Je±li w Ori-
ginie jest wª¡czona opcja Spreadsheet Cell Notation (a domy±lnie jest), to mo»emy operowa¢ na kolumnach
bardzo prosto. Na przykªad dodanie warto±ci (wierszami) kolumn A i B sprowadza si¦ do wpisania A+B (bez
znaku =) w polu F(x)= wybranej kolumny. Inaczej ni» w Excelu, mo»emy tej operacji dokona¢ równie» na
kolumnie A lub B, a niekoniecznie w nowej kolumnie, chocia» takie dziaªanie wymaga ostro»no±ci. W szcze-
gólno±ci, mo»emy np. pomno»y¢ warto±ci w kolumnie B przez 10, wpisuj¡c w komórce F(x)= kolumny B po
prostu 10*B. Mo»emy równie» operowa¢ pojedynczymi komórkami, np. A2 to druga komórka (drugi wiersz)
kolumny A. Przykªady dziaªa« na kolumnach s¡ pokazane na rys. 11. Uwaga � je±li dane w kolumnach
pochodz¡ z importu z pliku, to mog¡ by¢ mody�kowane powy»sz¡ metod¡ tylko je±li wyª¡czymy powi¡zanie
z plikiem ¹ródªowym (Disconnect Sheet).

Rysunek 11: Przykªady operacji na kolumnach i komórkach.

W trybie Spreadsheet Cell Notation nie mamy mo»liwo±ci zmiany nazwy kolumny (tzw. Short Name).
Ponadto, przydzielone nazwy (litery lub grupy liter) s¡ przez program zmieniane, gdy np. s¡ dodawane
nowe kolumny pomi¦dzy te ju» istniej¡ce. Oczywi±cie Origin aktualizuje te nazwy w funkcjach wpisanych
przez u»ytkownika. Gdy wyª¡czymy tryb Spreadsheet Cell Notation, Origin b¦dzie si¦ zachowywaª tak, jak
w jego starszych wersjach. Mo»na wtedy zmienia¢ nazwy kolumn (Short Name) i nie s¡ one mody�kowane
przez program. Operacje na kolumnach trzeba jednak wtedy zapisywa¢ jak dawniej, np. col(A)+col(B) lub
col(A)[2]+col(B) (drugi element kolumny A + warto±ci kolumny B). Ta metoda zapisu dziaªa te» w trybie
Spreadsheet Cell Notation, ale podlega pewnym ograniczeniom. Tryb dziaªania na kolumnach mo»na zmie-
ni¢ klikaj¡c prawym klawiszem na belce okna z workbookiem, wybieraj¡c Properties. . . i zaznaczaj¡c lub
odznaczaj¡c odpowiednie pole.
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4 Tworzenie wykresów

Najwygodniejsza metoda tworzenia wykresów to zaznaczenie wybranych kolumn w arkuszu i klikni¦cie od-
powiedniej ikonki w menu dolnym. Je±li chcemy mie¢ wykres z jedn¡ (niezale»n¡) osi¡ pionow¡, mamy szereg
mo»liwych kon�guracji zaznaczania kolumn: Y, XY, XYY', XYY'Y",. . . , XY X'Y', itd. Gdy w arkuszu nie
ma kolumny X, wykres b¦dzie utworzony dla kolejnych liczb naturalnych. Je±li kolumna X istnieje (nawet
nie zaznaczona), to b¦dzie ¹ródªem danych dla osi poziomej. Zaznaczane kolumny nie musz¡ by¢ obok siebie,
a kolumny X nie musz¡ by¢ po lewej stronie kolumn Y. Zaznaczania kolumn, które nie s¡siaduj¡ ze sob¡,
dokonujemy standardowo z klawiszem ctrl.

Aby otrzyma¢ wykres z dwiema niezale»nymi osiami pionowymi (i dwoma zestawami danych), zaznaczamy
kolumny YY, XYY lub XY X'Y' i klikamy w menu dolnym ikonk¦ Double-Y (rys. 4 i 12).

1. zaznaczamy kolumny
(z klawiszem ctrl, gdy potrzeba)

2. klikamy

3. dostajemy wykres z dwiema niezależnymi
osiami Y

Rysunek 12: Przykªad tworzenia wykresu z niezale»nymi osiami pionowymi na bazie kolumn typu XY X'Y'.

Je±li mamy przygotowane równie» kolumny z warto±ciami niepewno±ci, mo»emy je zaznacza¢ wraz z za-
znaczaniem kolumn typu X oraz Y. Dzi¦ki temu od razu otrzymamy wykresy, na których te niepewno±ci
b¦d¡ widoczne. Je±li chcemy doda¢ niepewno±ci do wykresu na pó¹niejszym etapie, to jest to jak najbardziej
mo»liwe � patrz informacja poni»ej o narz¦dziu Plot Setup.

Wygl¡d wszystkich elementów wykresów (krzywe, punkty, niepewno±ci, osie i ich opisy, liczby, legendy)
mo»emy w szerokim zakresie mody�kowa¢. Cz¦±¢ z opcji jest dost¦pna od razu w drugim (ni»szym) górnym
menu po jednokrotnym klikni¦ciu obiektu (wielko±¢ czcionek, litery greckie, indeksy, grubo±¢ linii i wiele in-
nych). Wszystkie opcje np. dla osi liczbowych oraz linii czy punktów wykresu s¡ dost¦pne po ich dwukrotnym
klikni¦ciu. Edycj¦ legendy robimy po dwukrotnym klikni¦ciu na tek±cie lub klikni¦ciu prawym klawiszem i
wybraniu Properties. . . . Dwukrotne klikni¦cie na linii/symbolu w legendzie otwiera okno edycji wykresu.
Szczególnie zwracam uwag¦ na mo»liwo±¢ mody�kacji liczb przy osiach w zakªadce Tick Labels, gdzie mo»na
wybra¢ notacj¦ naukow¡, in»yniersk¡ czy podzieli¢ (pomno»y¢) wszystkie liczby przez staª¡ warto±¢.

Szybkie utworzenie wykresu z dwiema niezale»nymi osiami Y jest, patrz¡c gª¦biej, utworzeniem wykresu
z dwiema warstwami (Layers). Wida¢ to po pojawieniu si¦ dwóch kwadracików z cyframi 1 i 2 w lewym
górnym rogu okna z wykresem. Klikni¦cie prawym klawiszem na wybranym kwadraciku i wybranie Plot
Setup. . . pozwala na zarz¡dzanie danymi w danej warstwie. Mo»na tam decydowa¢, które kolumny i z którego
workbooka b¦d¡ dostarczaªy dane peªni¡ce funkcj¦ zmiennych zale»nych, niezale»nych, niepewno±ci (xEr
lub yEr) czy etykiet (L). Zmieniaj¡c kolejno±¢ wykresów u doªu tego okna metod¡ �przeci¡gnij i upu±¢�
mo»na decydowa¢, która linia na wykresie b¦dzie na wierzchu, a która pod spodem. Natomiast samego
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dodania kolejnej warstwy mo»na dokona¢ wybieraj¡c b¡d¹ Layer Contents. . . (przycisk Layer), b¡d¹ Layer
Management. . . Najprostsza metoda jednak to klikni¦cie odpowiedniej ikonki w prawym menu (rys. 2),
a nast¦pnie zarz¡dzanie zawarto±ci¡ w Plot Setup.

W razie potrzeby, mo»emy mody�kowa¢ rozmiar wykresu oraz zale»no±¢ geometryczn¡ mi¦dzy osi¡ X
i Y. W tym celu klikamy dwa razy w dowolnym miejscu wykresu (ale nie dalej, ni» si¦gaj¡ osie) i w okienku
Plot Details wchodzimy w zakªadk¦ Size. Tam mody�kujemy rozmiar wykresu, np. zmieniaj¡c warto±ci Left,
Top, Width i Height lub wymuszaj¡c proporcj¦ mi¦dzy osiami (Link Axis Length. . . ).

4.1 Funkcje

Origin pozwala zarówno na tworzenie osobnych wykresów funkcji (2D i 3D), jak i na dodawanie wykresów
funkcji do wykresów z danymi. Ponadto, funkcje mog¡ by¢ de�niowane zarówno standardowo, jak i parame-
trycznie.

od razu zwiększamy ze 100 do 1000

postać funkcji, opcjonalnie z parametrami

wartości parametrów,
jeśli ich używamy

zoo funkcji

numeryczne dane
wygenerowane
przez program

do narysowania wykresu

zakres danych na osi X
wybieramy teraz
lub (często lepiej)

po narysowaniu wykresu

Rysunek 13: Tworzenie wykresu funkcji.

Aby narysowa¢ standardow¡ funkcj¦ w nowym oknie, u»ywamy ikonki w menu górnym (rys. 3). Wpisu-
jemy potrzebne informacje w formularzu (rys. 13 dla standardowej funkcji 2D) i dostajemy pierwsz¡ wersj¦
wykresu. �eby wprowadzi¢ mody�kacje do funkcji, klikamy lini¦ wykresu (lub lini¦ w legendzie) dwa razy.
W formularzu (nieco innym ni» ten pierwotny) mo»emy zarówno zmienia¢ sam¡ funkcj¦, jak te» parametry
wykresu (grubo±¢, rodzaj i kolor linii itp.). Gdy wykres funkcji klikniemy jeden raz, pojawia si¦ (podobnie
jak przy zaznaczaniu kolumn) tymczasowy panel z przydatnymi narz¦dziami.

Je±li chcemy doda¢ kolejn¡ funkcj¦ do ju» istniej¡cego okna (czy to z funkcj¡, czy to z danymi z workbo-
oków), w górnym menu klikamy Insert → Function Plot. . .
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4.2 Layout

Bardzo przydatnym typem prezentowania danych jest tzw. Layout, cz¦sto u»ywany przy przygotowywaniu
wykresów do wklejenia do zeszytów laboratoryjnych lub na potrzeby zebrania danych do przedyskutowania.
W Layoucie mo»emy zamieszcza¢ wykresy, arkusze z danymi oraz inne obiekty, np. obrazki, oraz dodawa¢
tekst, strzaªki, itp. Nowy Layout tworzymy u»ywaj¡c ikony w górnym menu (rys. 3). Wykresy dodajemy
klikaj¡c prawym klawiszem w polu Layoutu i wybieraj¡c Add Graph. Wykresy w Layoucie nie s¡ osobnymi
obiektami, ale jedynie obrazami tych ¹ródªowych (zatem nie mo»emy ich tam mody�kowa¢) � po dwu-
krotnym klikni¦ciu wykresu w Layoucie jeste±my po prostu przenoszeni do okna z oryginalnym wykresem
i tam mo»emy dokonywa¢ jego standardowej edycji, a wprowadzone zmiany b¦d¡ automatycznie widoczne
w Layoucie. Rozmieszczanie wykresów i ich przeskalowywanie mo»na sobie uªatwi¢ narz¦dziami z prawego
menu (rys. 2). Przykªadowy Layout jest pokazany na rys. 14.

Rysunek 14: Przykªad Layoutu przygotowanego do wklejenia do zeszytu pomiarowego.
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5 Eksportowanie wykresów

Eksportowanie wykresów z Origina tak, aby mo»na ich byªo u»y¢ w sprawozdaniach czy artykuªach nauko-
wych, zawsze byªo nieco problematyczne. Wydaje si¦ jednak, »e udaªo si¦ znale¹¢ optymalne metody eksportu.
Narz¦dzie do eksportowania znajdziemy w File → Export Graphs → Open Dialog. . . (rys. 15). Mo»na tam
wybra¢ zarówno typ pliku wyj±ciowego, jak te» wskaza¢ eksportowane okna oraz wybra¢ parametry eksportu
(m.in. rozmiar obrazka i stopie« kompresji).

typ pliku

które okno
lub okna

eksportować

lokalizacja pliku;
najlepiej wybrać
Project Folder

warto zapisać nasze ustawienia
w szablonie

Rysunek 15: Panel eksportu wykresów i innych obiektów do plików.

Wyj¡tkowo, je±li chcemy wstawi¢ wykres do Worda, prawdopodobnie najlepsz¡ jako±¢ uzyskamy korzy-
staj¡c nie z narz¦dzia eksportowania, ale z aplikacji Send Graphs to Word (rys. 16. Mo»na te» próbowa¢ po
prostu metody �copy and paste� lub standardowego eksportu do pliku rastrowego .jpg lub .png, pod warun-
kiem ustawienia dostatecznie du»ej liczby pikseli w opcjach eksportu. Eksport do PNG przydaje si¦ równie»,
gdy chcemy przedstawi¢ dane w Internecie.

W pozostaªych przypadkach, czyli gdy u»ywamy ±rodowiska LATEXlub programów typu CorelDraw, zde-
cydowanie polecam eksport do formatu wektorowego. Który jednak format wybra¢? Niestety, w zale»no±ci
od wersji Origina i np. CorelDraw, sprawdzaªy si¦ ró»ne formaty. Obecnie wydaje si¦, »e je±li eksportujemy
do CorelDraw (gdy np. przygotowujemy plakat lub chcemy po dodatkowej obróbce w Corelu u»y¢ pliku
w LATEXu), najlepiej jest u»y¢ formatu EMF. W mojej kon�guracji wersji programów, wyeksportowane pliki
PDF nie s¡ czytane przez Corela, a pliki EPS s¡ czytane prawidªowo tylko dla bardzo specy�cznych usta-
wie« ich eksportu z Origina. Je±li chcemy wyeksportowanego pliku u»y¢ wprost w LATEXu, powinni±my u»y¢
formatu PDF. W oknie eksportu warto w Export Settings wybra¢ Margin Control → Tight zamiast Page.
Dzi¦ki temu usuni¦te zostan¡ do±¢ spore, domy±lne marginesy. Rys. 17 przedstawia wynik eksportu wykresu
do formatu PDF, bez zmiany »adnych dodatkowych parametrów, poza wspomnianym Tight.
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aplikacje

eksport do Worda

Rysunek 16: Eksport wprost do Worda.
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Rysunek 17: Wykres wyeksportowany do formatu PDF i wstawiony do LATEXa.
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6 Dopasowywanie funkcji

Niezale»nie od tego, jakie funkcje b¦dziemy dopasowywa¢, mo»emy (opcjonalnie) w ªatwy sposób wskaza¢
fragment wykresu, który ma by¢ u»yty podczas dopasowywania. W tym celu korzystamy z odpowiedniego
narz¦dzia w lewym menu (rys. 18). Po ustawieniu znaczników w wybrane miejsca wykresu, klikamy dwu-
krotnie na jednym z nich, »eby zatwierdzi¢ wybór. Uwaga � ta metoda nie dziaªa prawidªowo, gdy warto±ci
w kolumnie X nie zmieniaj¡ si¦ monotonicznie (oczywi±cie na samym wykresie nie jest to widoczne). W takim
przypadku mo»na r¦cznie wybra¢ zakres uwzgl¦dnianych w �towaniu danych w oknie �towania.

Rysunek 18: Wybieranie zakresu danych, dla których ma zosta¢ przeprowadzone �towanie.

6.1 Dopasowywanie funkcji liniowych i wielomianów

Najcz¦±ciej dopasowywanymi funkcjami s¡ na pocz¡tku funkcje liniowe oraz ogólniej � wielomianowe. Pro-
cedura jest bardzo prosta. Najpierw ewentualnie wybieramy zakres danych do �towania, zgodnie z opisem
powy»ej, a nast¦pnie wybieramy z menu górnego Analysis → Fitting → Linear Fit lub Polynomial Fit. W tym
drugim przypadku, w okienku �towania mo»emy wybra¢ stopie« wielomianu (Polynomial Order). Tu mo»emy
ju» zako«czy¢ przygotowania do �towania. Jednak w celu poprawienia jako±ci prezentacji danych lub szybkiej
analizy jako±ciowej wyników dopasowania funkcji, w oknie �towania, w zakªadce Fitted Curves Plot warto
zaznaczy¢ Span to Full Axis Range. Dzi¦ki temu dopasowana prosta (lub krzywa) b¦dzie poprowadzona przez
caªy wykres, zamiast ko«czy¢ si¦ od razu na skrajnych u»ytych danych (rys. 19). Wybranie tej opcji jest
mo»liwe zarówno przy dopasowywaniu prostych, wielomianów, jak i funkcji nieliniowych, ale w tym ostatnim
przypadku wyboru musimy dokona¢ w zakªadce Fitted Curves (okno �towania nieliniowego jest inaczej zor-
ganizowane � patrz rys. 22). Je±li do utworzenia wykresu wybrali±my równie» kolumn¦ z niepewno±ciami Y,
to b¦d¡ one uwzgl¦dnione w �towaniu. Je±li chcemy u»y¢ równie» niepewno±ci X, musimy wybra¢ Analysis
→ Fitting → Fit Linear with X Error.

6.2 Dopasowywanie funkcji Gaussa i innych

Szybka metoda dopasowania funkcji Gaussa lub podobnej to u»ycie narz¦dzia Analysis → Peaks and Baseline
→ Multiple Peak Fit. Uwaga: je±li na wykresie mamy kilka maksimów, to z przyczyn matematycznych nie
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Rysunek 19: Wynik dopasowania prostej do punktów z niepewno±ciami X i Y. Po prawej stronie jest po-
kazane okno �towania z miejscem wyboru rysowania dopasowanej funkcji na caªym wykresie. Z wykresu
celowo jest usuni¦ta tabelka z wynikami, poniewa» (zgodnie z opisem w osobnych wskazówkach do przygoto-
wywania sprawozda«), parametry znalezione w �towaniu maj¡ by¢ przedstawione odpowiednio zaokr¡glone
i z jednostkami, a posta¢ dopasowanej funkcji zapisana w czytelnej formie.

mo»emy do ka»dego maksimum z osobna dopasowywa¢ wybranej funkcji, bowiem zaniedbamy wtedy efekt
tzw. przyci¡gania pików. Ilustracja tego problemu jest przedstawiona na rys. 20. Narz¦dzie Multiple Peak Fit
umo»liwia prawidªowe dopasowywanie do jednego, jak te» wielu pików. Po jego wybraniu dziaªamy zgodnie
z rys. 21.
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dopasowania niezależne dopasowanie jednoczesne – prawidłowe

Rysunek 20: Obrazowe uzasadnienie konieczno±ci jednoczesnego dopasowywania funkcji Gaussa do krzy-
wych z wieloma maksimami. Zwró¢my uwag¦ na du»e ró»nice mi¦dzy skªadowymi krzywymi znalezionymi
z dopasowa«, zarówno w amplitudzie, jak i poªo»eniu.

Je±li pod koniec procedury dopasowywania klikniemy Open NLFit (zamiast Fit), b¦dziemy mogli skorygo-
wa¢ parametry pocz¡tkowe, zablokowa¢ warto±ci wybranych parametrów lub �uwspólni¢� wybrane parametry,
czyli wymusi¢ tak¡ sam¡ warto±¢ np. szeroko±ci dla wszystkich lub wybranych pików. To zaawansowane na-
rz¦dzie �towania jest tym samym, które jest u»ywane przy dopasowywaniu funkcji nieliniowych (w tym �
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1. wybieramy funkcję

2. dwukrotnie klikając na wykresie
wskazujemy Originowi wstępne

położenie maksimów

3. klikamy Fit i finalizujemy
fitowanie lub wybieramy

Open NLFit, jeśli potrzebujemy
podjąć bardziej

zaawansowane działania

Rysunek 21: Dopasowywanie funkcji do jednego lub wi¦cej maksimów (lub minimów). Finalnie otrzymujemy
dopasowanie takie, jak na rys. 20 po prawej stronie, wraz ze znalezionymi parametrami dopasowania.

wªasnych), opisanym w kolejnej sekcji (patrz rys. 22 i 23).

6.3 Dopasowywanie funkcji nieliniowych

Dopasowywanie funkcji musi by¢ prowadzone pod kontrol¡ u»ytkownika. Pozostawienie tego procesu samemu
Originowi cz¦sto prowadzi do ewidentnie bª¦dnych dopasowa«, ale zastosowanie wªa±ciwej procedury jest za-
wsze skuteczne. Istotne etapy procesu dopasowywania funkcji s¡ pokazane na rys. 22. Zwró¢my uwag¦, »e
klikni¦cie przycisku Fit od razu w etapie 1. spowoduje przeprowadzenie procedury �towania, zamkni¦cie pa-
nelu kontroli i narysowanie znalezionej funkcji. Problem w tym, »e w wielu przypadkach dopasowanie b¦dzie
bª¦dne � Origin zatrzyma si¦ w minimum lokalnym optymalizowanego parametru. Niestety, nie da si¦ ju»
poprawi¢ dopasowania � trzeba procedur¦ powtórzy¢ od pocz¡tku. Dlatego w etapie 1. klikamy przycisk
Fit until converged, a nie Fit. Je±li dopasowanie nie jest prawidªowe, przechodzimy do zakªadki Parameters
(etap 3.) i staramy si¦ wprowadzi¢ (nieraz metod¡ prób i bª¦dów) dobre parametry startowe. Cz¦sto pomaga
te» tymczasowe zablokowanie warto±ci jednego lub wi¦cej parametrów (etap 4.). Je±li wynik dopasowywania
jest obiecuj¡cy, odblokowujemy parametry, doka«czamy procedur¦ (przycisk Fit) i otrzymujemy wynik ko«-
cowy (etap 5.). Gdy dopasowujemy kilka funkcji np. Gaussa (tak, jak to jest opisane w poprzedniej sekcji),
w zakªadce Parameters mamy mo»liwo±¢ sprawienia, »e wybrany parametr (lub parametry) b¦dzie taki sam
dla wszystkich funkcji � np. szeroko±¢ (rys. 23).
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kategoria funkcji

funkcja

postać funkcji

typowy wykres funkcji

nie klikać
aktualny stan fitu
(nieoptymalny)

problem ze zbieżnością

rozpoczęcie fitowania

zakładka Parameters
zmienione i chwilowo zablokowane

wartości dwóch parametrów

aktualny stan fitu
(bliski optymalnego)

wartości parametrów
dopasowywanej funkcji

(do modyfikacji)

wynik końcowy, po odblokowaniu parametrów
i dokończeniu fitowania

1. 2.

3. 4.

5.

Rysunek 22: Procedura dopasowywania funkcji z kontrol¡ parametrów pocz¡tkowych.
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Rysunek 23: Dodatkowa mo»liwo±¢ kontroli procedury �towania w przypadku dopasowywania kilku krzywych
np. Gaussa.
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